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CHAPTER1 UNDERSTANDING THE .NET FRAMEWORK

that all the other NET languages do—so under the hood, there is no longer any distinction to be
made between the two linguistic cultures. It's just on the surface, where we programmers work, that
the differences reside.

OOP itself, like biology, involves a complex system of classification. This means that people using
OOP must spend a good amount of their time performing clerical duties (Where does this go? How
do I describe this? What category is this in? Are the text-manipulation functions located in the Text
namespace, or the String namespace? Does this object have to be instantiated, or can I just use its
methods directly without creating the object first?)

Why Read This Chapter

If you're one of the millions of VVB programmers who, like me, came upon VB.NET with the highly
intelligent reaction “Whaaaaa?!!,” this chapter might be of use to you.

I’'m not unintelligent, and I'm assuming you're not either. But slogging through the VB.NET
world makes one seem rather slow, especially at first. This chapter gives you some hard-won advice that
can save you considerable confusion.

VB.NET is, of course, far easier to navigate if you have a background in C programming lan-
guages (and its lovely wife, object-oriented programming).

Millions of VB programmers deliberately decided not to use C. That’s why we became VB pro-
grammers in the first place. We preferred the power of VB's rapid application development tools. We
didn't care for the reverse-Polish backward syntax, the redundant punctuation (all those semicolons)
and other aspects of C and its daughter languages.

The Internet changed all that—we must develop new skills and adapt to new programming styles.
Leaving the cozy and predictable world of local programming (applications for Windows, running
on a single computer) requires new techniques. You don't have to switch to C or its ilk, but you do
have to expand your VB vocabulary and skills.

Today’s programs are sometimes fractured into multiple programlets (distributed applications)
residing in different locations on different hard drives and sometimes even using different platforms
or languages. V\eb Services are the wave of the future, and this kind of computing greatly increases
the impact of communication and security issues. Not to mention the necessity of encapsulating
code into objects.

So gird your loins or whatever else you gird when threatened, and get ready for some new ideas.
You've got to deal with some different notions.

Each of us (the authors) has written several books on VVB.NET in the past few years —working
within the .NET world daily for three years now—and we're still discovering new tools, concepts, and
features. Part of this is simply getting to know the huge .NET Framework, and part of it is adjusting
to OOP and other C-like elements that are now part of \VB.

What they say of quantum mechanics applies to OOP: only ten people in the world understand it
well, and nobody understands it completely. So be brave. You can learn some patterns and rules to
help you get results in .NET, and the benefit is that VB.NET is quite a bit more powerful and flexi-
ble than traditional \/B. There are considerable rewards for your patience and efforts.

You'll find ideas in this chapter that will deepen your understanding of the great, vast .NET envi-
ronment and framework. You'll find useful information here that will improve your VB.NET pro-
gramming—quaranteed. For example: What are structures, and when should you use them? (They're



HELP!

a replacement for classic VB's user-defined types, and you should never use them. OOP experts say
that whenever you're tempted to use a structure, create a class instead—it's more flexible. Of course
other OOP experts disagree, and the squabbling begins.)

Help!
A significant effect of the merging in of VVB with C-style languages is that the VB.NET Help system
and documentation were mostly written by C programmers. These people are not generally writers nor
are they very familiar with Visual Basic. That's why you find techno-speak error messages, convoluted
descriptions in the Help system, and other foggy patches.

So, instead of V/B's justly acclaimed clarity, we get Help descriptions that sound like they were
written by a barmy IRS bureaucrat. Here’s an example:

Changing the value of a field or property associated with any one instance does not affect the value of fields or
properties of other instances of the class. On the other hand, when you change the value of a shared field and
property associated with an instance of a class, you change the value associated with all instances of the class.

Got it?

Not only is the VB.NET documentation all-too-often puzzling, the fact that C programmers
wrote it means that the descriptions and even the source code examples are often some half-English,
half-C beast.

Many Help source code examples listed as “VVB.NET” versions are, in fact, written by C pro-
grammers. VVB programmers must spend the time to translate this faux VB code. It's great that there
is now so much tested, bug-free example code in Help. However, perhaps Microsoft would be wise to
ask experienced VVB programmers to go over the pseudo “Visual Basic” code examples, and translate
them into actual VVB-style programming.

For example, take a look at the entry in Help for string.Indexof. If you scroll down the right
pane, you can see all the ways that the sample code is not typical VB code. Many VB programmers
will have to figure out how to actually make this code work. It can't just be copied and pasted.

VB programmers can be confused by some of the strange punctuation and other odd qualities of
the following, and many other examples you find in Help. Although nominally Visual Basic source
code, too many Help examples are alien in many particulars, as you can see in this sample code illus-
trating the IndexOf method:

Imports System
Class Sample

Public Shared Sub Main()

Dim brl As String = _

L Sy Sy S S
Dim br2 As String = _
"0123456789012345678901234567890123456789012345678901234567890123456"
Dim str As String = _

"Now is the time for all good men to come to the aid of their party."
Dim start As Integer
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Dim at As Integer
Dim [end] As Integer
Dim count As Integer

[end] = str.Length

start = [end] / 2

Console.WriteLine()

Console.WriteLine("Al1l occurences (sic) of 'he' from position {0} to {1}.", _
start, [end] - 1)

Console.WriteLine("{1}{0}{2}{0}{3}{0}", Environment.NewLine, brl, br2, str)
Console.Write("The string 'he' occurs at position(s): ")

count = 0

at = 0

While start <= [end] AndAlso at > - 1
' start+count must be a position within -str-.
count = [end] - start
at = str.IndexO0f("he", start, count)

If at = - 1 Then
Exit While
End If

Console.Write("{0} ", at)
start = at + 1

End While

Console.WriteLine()

End Sub 'Main

End Class 'Sample

This example was obviously written by a C programmer who had little experience with Visual
Basic programming. There are several giveaways. First is the use of a class to illustrate a simple, small
programming technique. Creating a class for this purpose is overkill, though some strict OOP enthu-
siasts insist that everything in programming must be an object.

Also, Visual Basic programmers almost never use Sub Main. Instead, we use the Form1_Load
gvent as the startup object. For one thing, this event is the default startup object in Visual Basic. Pro-
grammers using languages that are not form-based, such as C, employ sub Main as their entry point
when a program begins execution. There is no default FormZ1 in C, so C programmers are accus-
tomed to starting their programs in sub Main (which is where they put initialization code, and also
where they test short code samples).

To make the many “VB” code samples in Help work, aVVB.NET programmer must right-click
the project name in Solution Explorer, choose Properties, then manually adjust the startup object in
a Property Pages dialog box.

Another giveaway that this isn't true VB is the line Imports System. VB.NET programmers know
that by default the System namespace is always available and need not be imported.

Also, VB.NET programmers do not use the brace {3} symbols to fill in fields when displaying
results, nor do we use the word End as a variable name, requiring that it be enclosed in brackets [ ].
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In fact, until VB.NET, the Visual Basic language didn’t even permit the use of braces, semicolons, or
brackets. Blessed simplicity, including the avoidance of extraneous junk punctuation, has always been
a hallmark of Visual Basic.

To make this usable, to-the-point, Visual Basic-style sample code, you have to eliminate the C-flavored
elements. What follows is a simplified, and pure-VB.NET, translation of this same sample. In addi-
tion to being written in recognizable VB programming style, it also has the advantage of focusing on
IndexOf, the method being illustrated. The example displayed above from Help is overly complex:
involving a loop, word counting, and one of the less frequently used of the IndexOf method’s over-
loaded variations. The idea that the example is supposed to be demonstrating gets lost in a mess of
irrelevancies. To be really helpful to VB programmers, Help code and Help narrative explanations
should be written by a professional writer/programmer, not simply someone technically competent,
with a strong C bias. And the example code should simply illustrate the method being explained,
like this:

Private Sub Forml_Load(ByVal sender As System.Object, _
ByvVal e As System.EventArgs) Handles MyBase.lLoad

Dim s As String = _
"Now is the time for all good men to come to the aid of their party."

Dim found As Integer = s.IndexOf("men")
Console.Write(found)

End Sub

Grappling with Framework Class Descriptions

You have to learn how to translate the class descriptions in the Object Browser, online documenta-
tion, or Help into useable VB code. Sure, there’s example code in many Help entries, but that code
all too often doesn't precisely demonstrate the syntax you are looking for (it was written by C pro-
grammers, after all).

Other entries offer no example code at all. There are tens of thousands of members in VVB.NET,
each with its own signature (parameter list) or set of signatures (thanks to overloading). And as
you'll see in this chapter, even seemingly similar classes can require quite different instantiation and
different syntactic interactions with other classes to accomplish a particular job.

You therefore frequently have to read a description in Help, the Object Browser, or other docu-
mentation and then translate that description into executable source code.

Press Ctrl+Alt+J to open the VB.NET Object Browser. Locate System.IO.File, then in the right
pane locate the first version of the Create method, as shown in Figure 1.1. In the lower pane, you see
this information:

Public Shared Function Create(ByVal path As String) As System.IO.FileStream
Member of: System.IO.File

5
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Too bad. What we want isn't always what we get. For all its power and virtues, .NET is riddled
with idiosyncratic, patternless constructions. Solecisms abound.

The situation is similar to the way that prepositions are used in English. There are no fixed rules that
govern prepositions, yet they serve to shade the meaning of many sentences. Probably the single most
obvious clue that a speaker is relatively illiterate (once they get verb forms figured out) is the misuse
of prepositions. Because there are no rules, each person refines his use of prepositions by listening to
educated speakers (not local TV reporters) and reading well-written text (not local newspaper sto-
ries). For example, many people use the preposition for inappropriately—using it as an all-purpose
substitute when they don't know the correct preposition. An example: “There’s a good chance for
rain.” (Should be “of”)

Having worked with VVB.NET on a daily basis for years now, | can tell you that your educated
guesses about writing instantiation code and how to employ other syntaxes will improve over time. But
you'll never discover any fixed, reliable rules. There are too many exceptions, too many peculiarities.

Here’s an illustration. The first confusion when trying to grammatically diagram the items shown
in Figure 1.2 comes from the fact that two classes appear to be working together to accomplish the
job of creating “a file in the specified path”: System.10.FileStream and System.I0.File. Both a
filestream and a file object must be used in your code. However, since they both belong to the
System.lO namespace, you need only import that single namespace:

Imports System.IO

The namespaces that are automatically added as defaults to each VB.NET Windows-style project
are: System, System.Data, System.Drawing, System.Windows.Forms, and System.XML. These
defaults, however, have changed in the past, and are likely to change in the future. One wonders: Why
include the little used System.Drawing as a default namespace?

In addition, NET automatically includes some less visible default namespaces—as you'll see later
in this chapter in the section titled “Assemblies Three Ways.”

Given that essentially everything is an object during runtime (including an integer variable, for
example), you can expect that sometimes you may have a single line of code that involves objects
from more than one namespace. Your first job when translating .NET documentation, then, is to see
what namespaces are referenced in the example code, and Imports them.

Next, you usually need to figure out what kind of object is returned from the method you're
working with. In the example in Figure 1.1, you can see that you must instantiate a FileStream object.
Why? Because the function (method) Create returns a FileStream object. You can instantiate your
FileStream object two ways:

Dim fstream As FileStream
fstream = File.Create("c:\myfile.tst")

or you can put the whole thing on a single line:
Dim fstream As FileStream = File.Create("c:\myfilex.tst")

Notice that sometimes when you instantiate an object you must use the New keyword (triggering its
constructor method). Other times you don't need it. A FileStream object can be created without the
New constructor, as can other common objects, such as a string. But don't relax: other, equally com-
mon, objects must be instantiated with Neew. Sometimes you use New; sometimes you don't—and
there’s no pattern or rule you can learn.

7
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Nope. Try it and you're told that “Overload resolution failed because no accessible ‘New’ accepts
this number of arguments.” Too bad that whoever wrote this error message didn't bother to translate
it into English. Visual Basic is famous for its English-like syntax and its avoidance of silly techno-talk
and garbled phrasing. That's why VB is by far the world’s most popular programming language. 1t’s
sensible and attempts to be straightforward. Alas, .NET is something of a setback in this depart-
ment, but the Help feature and other documentation has been considerably improved in the past
three years, and continues to become increasingly clear and sensible. Perhaps Microsoft will hire a
writer who knows VB to continue the improvements. One can hope.

This “Overload resolution failed because no accessible ‘New’ accepts this number of arguments”
error message seems to mean that the Directorylnfo class doesn't have a constructor that requires no
parameters. In other words, in the Directorylnfo class, there is no sub New(), a constructor that
requires no parameters. However, that’s not precisely the problem.

The DirectorylInfo class requires that you pass it a string containing a filepath. If you look up
DirectorylInfo in Help, and look at its constructor, you find this, its only constructor:

[Visual Basic]
Public Sub New( _
Byval path As String _
)

This seems to mean that you cannot instantiate a DirectoryInfo object without passing a file path to
it. How about the FileStream object? It's similar to Directorylnfo because it also needs a file path to do
its job. Why aren't these two similar objects—FileStream and Directorylnfo—created the same way?

It's really curious, but some of the rules and behaviors in .NET are merely quixotic, a matter of
what seems to us programmers to be mere whimsy. The FileStream object’s constructor is overloaded:;
there are nine versions of its constructor (nine different “signatures” meaning “parameter lists”). But
FileStream, like DirectoryInfo, offers no constructor that requires no parameters.

Here’s the simplest description given by the Object Browser of how to use the DirectoryInfo
object’s CreateDirectory method:

Public Function GetDirectories() As System.IO.DirectoryInfo()
Member of: System.IO.DirectoryInfo

Summary:
Returns the subdirectories of the current directory.

Return Values:
An array of System.IO.DirectoryInfo objects.

Clearly, you must create an array that can hold DirectoryInfo objects, but first you have to create
another DirectoryInfo object (and in the process of instantiating it, its constructor demands that you

supply a path):
Dim di As DirectoryInfo = New DirectoryInfo('c:\")
Then you instantiate the array (without using As New) and execute the GetDirectories method:

Dim dirs As DirectoryInfo() = di.GetDirectories()

9
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its sub New is executed automatically. Because constructors can accept arguments, the person who
writes a class can specify which arguments, if any, are required (or optional, in the case of overloaded
constructors).

Assemblies Three Ways

Recall that you needn't use an Imports statement to use objects in the XML namespace or the data
namespace. You do, however, need to use Imports with other namespaces, including quite commonly
used ones such as system. 10. T here appears to be no rational reason why certain assemblies are refer-
enced by default, and others need to be imported. (One clue is perhaps that nearly any C code you
look at always contains #include <stdio.h>, the standard I/0O library.)

Beyond that, there is even a third class of assemblies that cannot be referenced by Imports. They
are included in your projects by choosing Project > Add Reference.

Another curiosity. You find one list of default assemblies in the References section of Solution
Explorer, and a slightly different list of assemblies (including the Collections namespace) when you
right-click the name of your project (it's boldface) in Solution Explorer, choose Properties from the
context menu, then click the Imports option in the left pane of the Property Pages dialog box. You
see that only some namespaces here duplicate those in Solution Explorer. What gives?

Understanding Data Types

Earlier you saw how to use the GetDirectories method of the DirectoryInfo object to obtain a list of
subdirectories:

Dim di As DirectoryInfo = New DirectoryInfo('c:\")
Dim dirs As DirectoryInfo() = di.GetDirectories()

Here’s how you can use the Directory object to get a list of files. Notice that you use a string and
string array here, rather than DirectoryInfo objects. Also, notice that the Directory object does not
need to be instantiated at all:

Dim s As String() = Directory.GetFiles("c:\")
Dim s1 As String

For Each s1 In s
Console.WriteLine(sl)
Next

This is the information from the Object Browser, explaining that you need to assign the results of
the GetFiles method to a string array:

Public Shared Function GetFiles(ByVal path As String) As String()

Experienced VB programmers are used to a finite set of variable data types (strings, objects, and a
handful of numeric types). Now, in VB.NET, you must get accustomed to the fact that everything is an
object. Further, some objects must be instantiated before they can be used (with the New statement),
but other objects— viewed by the .NET designers as more “basic” objects, one assumes—do not need
instantiation. The Directorylnfo object does need instantiation; the Directory object does not.

11
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One clue about why the Directory object doesn't need to be instantiated is this description in the
Object Browser:

Public NotInheritable Class Directory
Inherits System.Object

The Directory object is low-level, like the Integer object—so you can just use it without instantia-
tion. The clue? It’s that this Directory class inherits right from the essence, the very heart of the
NET Framework, the base class System.Object. By contrast, the Directorylnfo class inherits from a
derived class (System.1O.FileSystemInfo):

Public NotInheritable Class DirectoryInfo
Inherits System.IO0.FileSystemInfo

About System.Object

The term base class is a bit too modest for System.Object; it's actually the mother of all .NET classes.
They all derive from System.Object, at least implicitly. System.Object does not inherit from any
deeper object—and it’s the only class in the entire measureless NET Framework that is not inher-
ited. It's the NET equivalent of the big bang.

Remember that .NET, unlike various C languages, does not permit multiple inheritance. (Being able
to inherit from more than one parent class has been the source of a great number of bugs for C pro-
grammers, who already have enough to worry about without adding this extra source of confusion.)

Other than System.Object, all other classes in .NET inherit from one (and only one) parent class.
However, a parent class can inherit from its own parent class, and so on up the line. Ultimately, at the
end of the ling, sits System.Object.

This is why when you look at the methods for any object in .NET, you always find at least the
same six methods—Equals, GetHashCode, Finalize, MemberwiseClone, GetType, and ToString—
no matter what other methods a class might have. Where do they come from? System.Object, of
course. What do they do?

Object types are called self-describing, like so many other current programming elements—notably
XML and its many offspring, and .NET assemblies with their metadata. Several of the six primary
object methods serve the purpose of describing the object.

MemberWiseClone
MemberWiseClone and Finalize are Protected, and can thus be accessed only from a child class.
Finalize, in fact, does nothing because it's overridden when inherited.

MemberWiseClone creates a “shallow copy” of the instance (the object). That means it copies
the non-static fields in the object. However, it does initialize the clone’s variables (fields) and proper-
ties. This works fine if the instance contains only value types, but if you want to, you can override
this method and define your own method of cloning your object.

Equals

Equals tells you whether two object variables point to the same object. The .NET compiler doesn't
permit you to use = (lest you get confused and think the result means equality in the sense that there
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are two distinct objects but they have identical members and are otherwise identical internally,
including their data—clones, in other words). You use Equals, like this:

Dim objl As New Object
Dim obj2 As New Object

objl = obj2

If objl.Equals(obj2) Then MsgBox("They are the same.")

When a class inherits an object type, the Equals method is supposed to be overridden. You pro-
vide a custom method to determine equality. Similarly, you should override the GetHashCode
method to ensure it remains consistent when two objects are equal.

Testing for equality can be tricky in computer programming because the idea of “equality” (two
objects holding an equal valug, such as 2.114) can be confused with “identity” (two object variables
pointing to the same object). The Equals method simply compares pointers, but many classes over-
ride this method to force it to compare values (for example, the Integer class Equals method tells you
whether two integer variables contain the same number).

ReferenceEquals
The System.Object type includes an additional equality testing method named ReferenceEquals. It
returns True if the two object variables being compared refer (point to an identical address in mem-
ory) to the same object. ReferenceEquals cannot be overridden. (Think of ReferenceEquals as doing
the job of the traditional Is comparison operator in classic VVB.)

For example:

Dim 1 As Object
Dim m As Object
Dim n As New Object

Console.WriteLine(Object.ReferenceEquals(1l, m))
m=n

Console.WriteLine(Object.ReferenceEquals(m, n))
Console.WriteLine(Object.ReferenceEquals(l, m))

results in:

o True (both refer to nothing—they are object variables but don't point to any object yet). This
can be very confusing because these are two different object variables, yet they return equality.

o True (both mand n refer to the actual object n. N is an object because you instantiated it with
the New command).

+ False (1 remains an object variable that has not been pointed to any object).

(Notice the unusual use of the term Object in Object.ReferenceEquals. Where is this Object ever
instantiated so that you can use it in your source code? It's not. It’s just there! Fortunately, this syntax
is extremely rare in VB.NET programming.)
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The Main Point about Equality

If you need to test for value equality, you can rely on the = test in most ordinary programming. To
test for reference equality (two object variables point to the same object), you can use the Reference-
Equality method. Take a look at this code:

1
2

Dim a As Object
Dim b As Object

If a.Equals(b) Then MsgBox("a.Equals b")
'a=b

If Object.ReferenceEquals(a, b) Then MsgBox("a.ReferenceEquals b")

If you run this you see no message box. Object a holds a value of 1 and object b holds 2, so they
are not “value equal.” (If a = b Then would also fail.)

Remove the ' comment from a = b and you've assigned a to point to (to reference) the same object
as b, so the ReferenceEquals message box is displayed.

Change object a to = 2 and the value equals (.Equals) message box is displayed because now the
values held in these two objects are identical.

Note that in .NET objects are of two primary types: value and reference. Value types tend to be
simple and small (all the numeric types are value types: integers, byte, char, single, double, boolean,
decimal). Enum and structure are also value types. Value types execute faster.

When value types are compared for equality, the actual values (323 versus 62, for example) are
compared. When reference types are compared for equality, only the addresses (pointers) where the
objects sit in memory are compared. A reference equality means that two object instances (two dif-
ferent object variables that point to an instantiated object) point to the same object. It’s like having two
names for the same thing: President and Bush.

Reference types are larger and more complex: classes (and interfaces), arrays, and strings are all
examples of reference types.

As usual, these classifications are important because you sometimes need to know the distinction
between reference equality and value equality when you're writing a program. Also as usual, there is an
exception. Strings are technically reference types but in practice they behave as value types: copying a
string copies the actual string in memory (the value) not merely the reference (the pointer to an
address). And when you test for the equality of strings, you are testing them as if they were value
types—in other words, if two different strings hold the same value, they return True.

You'll be delighted to know that the experts have a term describing this hermaphroditic behavior
on the part of .NET strings: If a reference type now and then acts like a value type (as strings do),
then that type is said to possess “value semantics.” Strings are technically reference types, but in prac-
tice they behave as value types. Fun, isn't it? Merrily we go along classifying this and that, happy little
biologists that we are! Then we see a platypus laying an egg. Reality, like programming linguistics,
always seems to have a way of messing up our neat little categories.

Technically, strings do not derive from System.Value Type, and they are also technically passed by
reference when used as an argument in a function (you don't see this, though; it all goes on in some
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dark recess of the .NET netherworld). Up in the sunlight where we programmers reside, strings are
pretty much always treated just as if they were value types. For example, like all other “objects”
passed as parameters in VB.NET, when you write any function, VB.NET fills in ByVal automatically
by default for every and any item in your function’s argument list.

WHAT’S SHARED, WHAT’S STATIC?

Why don’t you have to instantiate a Math object before using its methods, such as Abs or Max? The actual
answer is: just because.

But here’s the technical rationale: You’ve probably seen the term static (or class member) used with some
methods in the documentation for C#, C++, and all the other C family of languages. In VB.NET this same
trick is achieved by using the Shared command.

Ordinarily, if you want to use a method of an object you have to instantiate the object first. However,
methods (or events, properties, or fields) declared as Static (in C languages) or Shared in VB.NET can be
“invoked on a class” (translated: used in your programs) without your having to actually create an instance
of that class. What? How can a property or method be usable without any instance of its object? Isn’t that
rather similar to the idea of global variables? Global variables so enrage professors of OOP that they’ve been
known to shout “Verboten!” and slap their pointer against the blackboard so hard it breaks.

One example of a Shared method is the Max method. It tells you which number is larger than another. Sure,
Max is a method of the Math class, but you don’t have to instantiate a Math object in order to use the Max
method. No. It’s one of those privileged “shared” (AKA static) methods, so you can just use it in your code
directly. C languages use the term instance to refer to methods (or other members) requiring that you must
first instantiate their object before you’re allowed to use the functionality of the members. We’re figuring
out what goes where, aren’t we? Isn’t clerical work fun?

[Visual Basic] Overloads Public Shared Function Max(Byte, Byte) As Byte
[C#] public static byte Max(byte, byte);

You can’tinstantiate a Math object even if you wanted to. It’s Private. This won’t work:
Dim ma As New System.Math
You must instead just directly use the Math.Max method:

Dim x As Integer = 2 : Dim y As Integer = 4
MsgBox (Math.Max(x, y))

Shared members are an exception to the OOP rule that you’re supposed to instantiate an object before you
can actually, you know, useit.

Into the Void: While we’re on the topic of C terminology, what does the term void mean? You see it
quite often in the VB.NET documentation, though it’s not part of the VB language. If you see Pub1ic
Static Void, don’t be alarmed. Void is just C#, which means: nothing is returned from this proce-
dure. In other words, the procedure is what we VB programmers would call a Sub (as opposed to a Func-
tion). There’s no returned value, for example: Public Static Void Delete(string path).
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When you run across strings and objects behaving strangely, just relax. The string and object
types—I'm not talking here about every kind of object, but rather the actual object type, as in: If
Object.ReferenceEquals(a, b) Then—are special. They are exceptions to the “reference type” rules.
They are treated differently by .NET. They are called “built-in reference types” and this means they
are supposed to behave more like the good old built-in integers and booleans and other familiar data
types. (But don't be fooled; the built-in object type is a pretty odd bird.) Speaking of odd birds, con-
sider the Shared member, described in the sidebar titled “What's Shared, What's Static.”

GetHashCode

GetHashCode returns a number unique to the object. Think of it as a kind of GUID, a computer-
generated number intended to uniquely identify a particular object. The .NET hashcode for the
string “Helen,” for example, is always 222703087, but the hashcode for “Helex” is 222703097.
Store “Helen,” however, in two separate string variables and you get the same HashCode (as you
should). Some books claim that different objects containing the same value result in different hash-
codes. This is incorrect; sometimes you get the same hashcode, sometimes not.

Hashcodes are used two ways in .NET. A simple hashcode such as the one generated for Helen
can be used as a unique index number to check for duplicate values when an object is added to a col-
lection or hash table. This is useful to prevent duplicate entries, which are forbidden in a primary key
field, for example. Unfortunately, though, the GetHashCode method as implemented in
System.Object is relatively useless because unpredictable.

In general, inheriting classes override this GetHashCode method, and also override the Equals
method at the same time. Not only can they thereby provide more useful hashcodes, but can simulta-
neously ensure that objects that are equals also return the same hashcode.

A more sophisticated hashing algorithm is used in the NET Security assembly, and it can be used
quite effectively to generate unique keys from text passwords. This use of hashing is explored in Chapter 6.

GetType

The GetType method returns a data or object type. NET maintains metadata (information about
information, like the signs in a bookstore categorizing the books: Philosophy, Cooking, and so on).
Ina .NET assembly, each object is stored with a description of its nature and relationships. Get Type
can be used in your programming if you need to figure out the type of an object:

Dim xn As Type = s.GetType

For additional information on how to use GetType in reflection—a technology that takes advan-
tage of metadata—see Chapter 8.

ToString
The final fundamental method inherited from System.Object is ToString, and you know what that
does. Often overridden, ToString is also automatically invoked behind the scenes when you use com-
mon commands such as Console.WriteLine OF MsgBox.

ToString transforms some objects’ names or qualifications into strings so they can be seen in mes-
sage boxes or in the output window or otherwise viewed. | say some objects because in certain situa-
tions, ToString is optional. Read on.
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Strong Typing Weakens

For a decade, many VVB programmers used a quick debugging technique of printing variables directly
on a form to see their values. This convenience is missing in VB.NET (you can't print on a form with
a simple Print command). Instead, to see variables you have to use either a MessageBox or Console
Writeline to see results in the Output window. This has resulted in some modifications to the strict
rules governing the message box.

People were getting a little annoyed at having to type MessageBox. Show (x.ToString) each time
they were debugging and wanted to see this variable x. SO MessageBox Was shortened to MsgBox, the Show
was omitted, and, after a while, even the Tostring method was dropped. Now you can use the short-
hand version: MsgBox(x).

As you see, VB.NET is gradually abandoning some of the more onerous rules demanded by a
strict adherence to what they call strong typing.

Is Color a Data Type?

Yes. Each time you work in an area of .NET that you've not previously dealt with (or that you've
forgotten), you'll nearly always find yourself butting up against the problem of syntax and data typ-
ing. You see “cannot be converted” or “reference not set” or a handful of other error messages over
and over.

THE VARIOUS MEANINGS OF STRONG TYPING

The phrase strong typing is used in several different ways in computer programming literature. It some-
times means using descriptive strings as the keys in a collection, rather than using index numbers.

In other places, you’ll see strong typing described as the enforcement of a rule that each element in a collec-
tion be of a specific data type, not a generic “object” type. .NET Framework collections in fact do include
only object types, on the lowest level. And you can add anything to your collections, which is a useful free-
dom. But you are urged by OOP professors to “strongly type your collections.” Don’t just add objects and
only objects. They point out that it prevents someone ignorant of your collection’s purpose from adding,
say, an automobile type to a collection of fresh fruit types (which could cause errors). However, it seems to
me that this is actually a non-problem if you simply follow the usual OOP practice of always validating
incoming data. Still other OOP experts say that a fundamental virtue of strong typing is that type mismatch
errors are trapped during compilation rather than later at runtime. This claim ignores the fact that the
only time some outsider is submitting objects to your class is during runtime.

Here’s yet another, similar meaning of strong typing in the literature. It means that if you always be sure
to declare your data types, you avoid errors in VB.NET. In earlier versions of VB you could leave the type
ambiguous by using the Variant, or by implicit declaration (you never actually declare the variable’s type,
you merely use it in code by assigning a value to it—VB then interprets what kind of number it is, or if it’s a
string). Now, in .NET, you cannot use Variants, nor can you implicitly declare (you canturnOption Explicit
off if you wish). Nonetheless, you can be ambiguous by declaring a variable as an object type (and since
everything is an object, this is similar to declaring a Variant). However, you’re urged not to do this for three
main reasons: to permit IntelliSense lists, to allow type checking during compilation (so certain kinds of
incorrect data type usage are prevented), and to speed up compilation.
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If everything in .NET is an object, then everything is—at least abstractly—a data type. Fortu-
nately, it’s not this bad; within a given class, such as Color, there are enumerations that in themselves
aren't, technically, objects. However, most VB programmers are used to just assigning a simple string
(or at least a built-in enum, such as VVBBIue) to many different properties. For example:

Backcolor = "blue"

Now, in .NET, you must either use Imports to bring in a specialized namespace, or fully qualify
your value:

Me.BackColor = Color.Blue

The System.Drawing namespace is now included in current VB.NET projects by default, so you
don't have to fully qualify this one. The underlying problem here, though, is: How can you know that
there is a Color class, and that it’s located in the System.Drawing namespace? How do you deal with
unfamiliar parts of the .NET Framework? Color might be easy enough to imagine, or you might
finally come across example code by using the Help search feature to locate entries with BackColor =
But how do you deal with more complex situations, such as the Security namespace? Most books on
VB.NET avoid discussing the System.Security assembly precisely because it is both obscure and mas-
sive. This in spite of the fact that communication and security are the primary issues that distinguish
the .NET world from classical VB programming. Put another way: OOP itself is fundamentally a set
of rules designed to solve communication and, especially, security problems. Code reusability, the
primary justification for OOP, is largely an attempt to enforce communication rules to solve security
problems—though doubtless OOP theorists will consider this a reductive generalization.

Exploiting the Framework

But back to our regular programming. What are the best strategies for tapping into the tremendous
power (and consequent complexity) of the .NET Framework?

Remember that it’s hierarchical. .NET APIs are divided into namespaces. Namespaces contain a
set of related classes. Classes contain methods (and the methods are usually overloaded—permitting
you to perform different, but related, jobs based on what parameters you pass).

Let’s try to solve a common problem, to see some tactics you can use to locate the solution.

Assume that you have to parse a string. You've got a comma-delimited string from a use like
“Barry Morgan, 12 Dalton Ln., Akron, OH, 22022 and you want to subdivide it into its substring
parts. You want to create a string array holding each part.

Start by running VB.NET Help, then click the Search tab. Search for parse string. You get 500
hits, including a Dr. GUI article that tells you about the Parse method. Unfortunately, it doesn't parse,
it converts a string into other data types. Somebody incorrectly thinks that “parse” means convert.
When computer languages are written, the specification committees don't include any English
majors, so we get too many poorly named functions like this one, and too many nearly unreadable
“help” narrative descriptions.

Trying to narrow your search using quotes to look for “parse a string” fails. Lets try the Index feature.

Click the Index tab in the Help screen and type System.Text (no luck here, unless you want to
enter the complicated netherworld of Regex, which requires even more elaborate code than using
InStr to loop through your string).
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Try System.String. Nothing. Try leaving out System: Typing String. (don't forget the dot .) displays
a nice list of all the methods you can use with strings. The IndexOf method looks promising at first
glance. It's the replacement for InStr, and it does locate substrings, but it still forces you to write a
messy loop. Isn't there any way to just pass a delimited string to a function and get back an array of
the pieces? Doesn't this function exist?

How about String.Parse? No such entry. Keep looking. What about String.Split? Eureka. Help
describes it like this: “Identifies the substrings in this instance that are delimited by one or more
characters specified in an array, then places the substrings into a String array.” This near-English sen-
tence might be describing what we're after. Unfortunately there’s no mention here of the actual, neces-
sary word parse, but NET Help is being improved all the time. Eventually, it may even become nearly
understandable. One always hopes.

NET has only been out three years. Perhaps someday they’ll have the wisdom to get an actual
writer to rewrite the Help descriptions. If so, the Search feature will be more useful than it is today,
when searching for parse results in dozens of hits for the completely unrelated task of type conversion.

Between WWII and 1980 you would buy a transistor radio and get an instruction manual with
sentences like this: “Press top button on the bottom of our most handy top. Not blue. Then pause
fine. Happy you luck! Now hear song fast everywhere!” It only took the typical Asian electronics
manufacturer three decades before grasping the value of hiring a $14,000-a-year copy editor who
knows English to review equipment manuals for correct English.

The syntax for Split is displayed like this:

Overloads Public Function SpTlit( _
Byval ParamArray separator() As Char _
) As String()

So you have to pass an array of Chars specifying your delimiter(s), and it returns a string array.
You may or may not know how to build an array of characters. Again you have to search around. You
might think you can create the array, create a char variable holding your comma, then assign the vari-
able to the array, like this:

Dim ¢ As Char = ","
Dim delim As Char()
delim(0) = ¢

You get the famous “no object” error message from the compiler: “Object reference not set to an
instance of an object” Oh well. No point trying to figure out why you cannot just create and declare
an array, then fill it with values. When you come upon this kind of problem, try other syntaxes, or
hope there’s some example code in Help.

Another way to solve this problem is fairly strange, too. You create a string, then change it into a
char type using the ToCharArray method:

Dim delimStr As String = ","
Dim delim As Char() = delimStr.ToCharArray()

Why there is a ToCharArray method, but no ToStringArray method, is anybody’s guess.
The most straightforward way to solve the problem of adding values to a char array is to just Dim
the char array, and initialize it with the comma directly:

Dim delim As Char() = {","}



20 CHAPTER1 UNDERSTANDING THE .NET FRAMEWORK

Whoever wrote the Help entry for the Split method evidently was unaware of this approach. The
code example employs the bizarre, cumbersome ToCharArray method instead.

Note that VB programmers are unfamiliar with using braces in their programming, but in
VB.NET they can be used to fill an array with values, as this example illustrates. The rest of the code
is straightforward:

Dim delim As Char() = {","}
Dim tt As String = 'Barry Morgan, 12 Dalton Ln., Akron, OH, 22022"
Dim split As String() 'create string array

split = tt.Split(delim)

For i As Integer = 0 To split.Length - 1
Console.WriteLine(split(i))
Next

Here’s an even more exotic alternative syntax. It combines the declaration of the string array with
the declaration of the character array:

Dim split As String() = tt.Split(New [Char]() {","})

This is exotic to VB programmers partly because it uses brackets in addition to braces—neither
punctuation is used in classic VB. It's also exotic in that a single logical line of code manages to declare two
arrays, and to add a value to the second array.

Whatever. It's fine that there are several ways to create and fill a character array. Just fiddle around
until you come upon a syntax that works.

A Useful Class View Utility

WInCV (Windows Class Viewer) comes with .NET. It offers you yet another view of the details of
every class.

Tip I you're not sure where to begin in WInCV or other Framework references, or if you want a useful descriptive
overview of the available .NET classes, click on the Contents tah at the hottom of the VB.NET Help window, then follow
this path in the tree in the left pane: Visual Studio NET\.NET Framework\Reference\Class Library. You'll see all the
namespaces there, and all the classes within them.

To add WIinCV to the IDE, choose Tools > External Tools and type WinCV into the Title
field. Click the ellipsis ... button next to the Command field. Now find WinCVexe in this path:
C:\Program Files\Microsoft Visual Studio .NET 2003\SDK\v1.1\Bin\WinCV.exe.(” you
haven't upgraded to VS.NET 2003, the location may be .NET 2002 or simply .NET.)

Choose Project Directory in the Initial Directory field, and click OK to close the Open File dia-
log box. WinCV is now available from the VB.NET Tools menu.
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A HANDY C# TO VB.NET TRANSLATOR

As you know, unfortunately some .NET Help and reference source code is written in C# (particularly
online examples). However, C# is actually quite a simple language to understand and to translate into
VB.NET. C# shares some of the backwards syntax of other C languages, and of course all those semi-
colons—but you can generally switch the C# source code lines around pretty quickly to get usable VB.NET
code. However, if you don’t want to bother, there’s a handy translator that takes C# and generates the equiv-
alent VB.NET. Find it at www. kamalpatel.net/ConvertCSharp2VB.aspx, and the utility is also available
with full source code showing the process and the rules. If you prefer, though, you can just paste some C#
and get the result automatically.

Choose Tools > WinCV and then type string in the Searching For box. You now see all the mem-
bers of the string class, in a helpful quasi source code format. It's not VB, unfortunately; it's C#—
but if you ignore the useless semicolons ending each line, and make a few other allowances (such as
changing brackets to parentheses), it often provides a better overall view of a class’s members than
you get in Help. For example, the entry for the Split method looks like this:

public string[] Split(char[] separator);
public string[] Split(char[] separator, int count);

You have to add the object for the method (String.), so after a little VB massaging it actually
should look like this:

String() = String.Split(char() separator)

That's pretty descriptive pseudo-code. The WInCV is good for quick overviews of classes, their
overloaded members, and correct syntax.

A Brief Lexicon

Given that C usage has permeated VB.NET, you might want to memorize the definitions and com-
parisons in Table 1.1. You'll come upon them now and then in the .NET documentation, and it
helps to know what terms have shifted meaning. This small list supplements the other C-derived
terms discussed at greater length throughout this chapter. Note that many of these term-pairs are
still used interchangeably.

TABLE 1.1: VB vS. VB.NET TERMINOLOGY

TRADITIONAL VB USAGE .NET

Private or Ppublic variables inside classes Fields

DLL, library, or application Assembly

Related DLLs, libraries, or applications Namespace (imprecise in size: there can be multiple name-

spaces within a single assembly, or a single namespace can
include several assemblies. Namespaces can even contain
other namespaces.)

Continued on next page
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TABLE 1.1: VB VS. VB.NET TERMINOLOGY (continued)

TRADITIONAL VB USAGE .NET

Project (an application and its dependencies) Solution (design-time source code) or Assembly (runtime
executable and support). A Solution can contain multiple
projects, in which case you must specify the “startup proj-
ect” in the Project menu.

Classes, arrays, modules, enumerations, struc- Types
tures, interfaces, and value types, collectively.

Code Managed code (runs under the control of the .NET
runtime library. C++ programmers can choose to write
unmanaged code.)

DOS Application Console Application

Form1 Load Sub Main

RecordSet DataSet

Fields and records in databases Columns and rows in databases

Built-in constants An enumeration (or enum)

User-defined type Structure

Error Exception (or, when working with XML, Fault)
Trapping errors Handling exceptions

Classes are Public by default Classes are Friend by default
Summary

In this chapter I tried to explore and describe ways to successfully approach VB.NET. | wanted to
help you come to grips with this important language, giving you tools and concepts necessary to
master it. Learning to use VB.NET is well worth the effort: VB.NET is quite powerful and flexible, a
significant improvement over traditional \VVB.

But there is effort required. .NET is a new world. And, alas, Microsoft’s documentation for
VB.NET (both online and in the Help system) is mostly written in a language somewhat like Eng-
lish, and the code examples are usually similar to VB.NET code. Similar, somewhat like, but...you'll
laugh, you'll cry, you'll pull your hair.

All too often the C programmers who wrote the Help descriptions are better programmers than
writers. And they're better C programmers than VB programmers, writing code examples that can
best be described as Javaesque—\Visual Basic from an alternative universe. Close, but not right.

Nonetheless, adapting to a powerful, new, cutting-edge computer technology requires that you
sacrifice some time and make some effort. | hope that this chapter has given you guidance and tools
that simplify the process. VB.NET—aonce you're at ease with it—expands your programming abili-
ties in ways you never imagined.



